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I. SoC 설계 구조 이해 및 프로그램 설치 방법

1. SoC 설계를 위한 EasySoC 실습장비 소개

1.1 EasySoC 설계 키트

EasySoC는 사용자가 로직을 구현하기 쉽도록 FPGA에 기본적인 IP가 구현되어 있으며, ALTERA Quartus II FPGA 설계 환경에서 동작된다. 또한 1백만 게이트 Altera Cyclone II FPGA에서 실습하도록 다양한 예제가 제공되며, 제공되는 예제를 통하여 AMBA 버스 연결에 대한 이해를 하도록 하였다

[image: EasySoC_Flow]

1. 2 SoC 설계를 위한 소프트웨어

EasySoC 실습키트를 이용하여 SoC 설계를 성공적으로 수행하기 위해서는 EDA 툴이 필요하다. 하드웨어와 소프트웨어 IP들이 매우 복잡하게 연결된 SoC 설계에서 이러한 IP들이 기능적으로나 물리적으로 제대로 연결되어 동작되는지를 보장받기 위해서 다양한 EDA툴들을 사용하여야 한다. 또한, EDA 툴의 사용은 SoC 설계 시간을 단축시킴으로써 시장진입시간을 최소화할 수 있는 장점이 있다. 본 Manual에서 사용되는 EDA 툴은 다음과 같다.

1) Quartus II
Altera(www.altera.com)사의 Quartus II는 CPLD/FPGA의 디자인 시작(Design entry) 단계부터 최종 프로그래밍 작업까지 통합된 환경(Project navigator)에서 쉽게 디자인할 수 있도록 지원하는 툴이다. 포함하고 있는 각각의 프로그램을 이용해서 논리회로합성, 매크로셀 매핑(Mapping), 배치배선(P&R)등을 손쉽게 수행할 수 있다.
2) ModelSim
ModelSim(www.model.com)은 Mentor사에서 개발한 HDL Simulator의 한 종류이다. HDL Simulation을 수행하기 위해서는 HDL Simulator가 필수적이다. 예전에는 HDL Simulator들이 VHDL이나 Verilog를 분리해서 지원했으나, 요즘에는 통합하여 동시에 지원하기 때문에, Verilog로 설계된 모듈과 VHDL로 설계된 모듈을 통합하여 Simulation하는 것이 가능하다.

3) ADS (ARM Development Suite)
ADS는 ARM(www.arm.com) 계열 프로세서를 위한 소프트웨어 개발 툴 패키지이다. 이 툴은 C/C++ Compiler, assemble, linker, in-circuit debugger, 등등의 유틸리티들을 제공한다. 본 시스템에서는 ADS를 이용하여 in-circuit debugger인 Multi-ICE를 사용하여 프로그램을 디버깅할 수 있다. 



2. ARM Processor를 이용한 SoC 설계 구조 이해

2.1 EasySoC ARM926EJ-S 프로세서

EasySoC에서 사용하는 ARM926EJ-S 프로세서는 ARM 9계열의 System On Chip(SoC)이다. ARM926EJ-S는 외부에 AMBA AHB (Advanced High-performance Bus)를 가지고 있으며 사용자가 설계한 IP(Intellectual Property)를 연결할 수 있도록 되어 있다. 이장에서는 ARM 프로세서 특징 과 내부 Block Diagram과 Memory Map에 대해 소개한다.

2.2 ARM926EJ-S 프로세서 특징

▪ ARM926EJ-S RISC 프로세서
▪ 최대 주파수 266MHz
▪ MMU(Memory Management Unit) 이용에 따른 가상 주소 지원
▪ 32KB Instruction Cache
▪ 16KB Data Cache
▪ 8KB Instruction TCM (Tight Coupled Memory)
▪ 8KB Data TCM (Tight Coupled Memory)
▪ Coprocessor 내장
▪ JTAG (Joint Test Action Group)
▪ ETM9 (Embedded Trace Macrocell), FIFO(First In First Out)




2.3 프로세서 블록 다이어그램
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[Block Diagram]

2.4 Memory Map
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[image: ]

 EasySoC에서는 ARM과 외부 FPGA를 연결하여 설계된다. 외부 FPGA로 접근할 수 있는 메모리 어드레스 영역은 0x2000_0000 ~ 0x3FFF_FFFF 이다.

3. AMBA Protocol의 이해

3.1 AMBA 규격의 개요

 AMBA(Advanced Microcontroller Bus Architecture)는 ARM사에서 만든 규격으로 Embedded Microcontroller 의 설계에 필요한 버스 프로토콜 규격이다

· 3가지 AMBA 규격
1. The Advanced High-performance Bus (AHB)
2. The Advanced System Bus (ASB)
3. The Advanced Peripheral Bus (APB)

3.2. AMBA 기반의 마이크로 컨트롤러

AMBA 기반의 마이크로 컨트롤러는 일반적으로 AHB나 ASB를 시스템버스로 사용한다. 여기에는 ARM과 같은 CPU나 DMA등이 연결될 수 있다. 또한 저속이면서 저 전력 주변장치와의 통신을 위해서 APB가 붙을 수 있는데 이것은 ASB나 AHB의 로컬버스처럼 여겨지며 브리지(Bridge)를 사용하여 연결된다.


[image: image22162406191_guile21c]
3.3 AMBA AHB 소개

AMBA AHB는 고성능, 고속 시스템에서 필요로 하는 특징들을 구현한다. 이를 위한 AMBA AHB의 특성은 다음과 같다.
▪ Burst 전송
▪ Split 처리
▪ 한 사이클 이내에 버스 Master 변경
▪ Clock 상승 에지 동작
▪ Non-tristate 수행: Write Data와 Read Data 버스 분리
▪ 폭넓은 데이터 버스 구성 (64/128 bits)

AMBA AHB에는 하나 또는 그 이상의 버스 Master가 연결된다. 이러한 것들에는 DMA나 ARM Core같은 것들이 연결 될 수 있다. 외부 메모리 인터페이스나 APB브리지 등은 AMBA AHB의 Slave로 연결 될 수 있다. 그러나 저속의 주변장치들은 APB를 통해서 연결이 되어야 한다.

AMBA AHB 시스템을 구성하는 요소는 다음과 같다.
	구성 요소
	상 세 설 명

	AHB Master
	버스 Master는 Address나 제어신호들을 내보냄으로 읽기나 쓰기의 동작을 할 수 있도록 해 주는 장치이다. 단 한 번에 하나의 Master만 전송 가능하다.

	AHB Slave
	버스 Slave는 주어진 Address공간 안에서 읽기와 쓰기를 가능하게 해주는 장치이다. Slave는 Ready 등의 신호를 통해서 Master로 하여금 기다리게 하거나 전송이 잘 못되었음을 알린다.

	AHB Arbiter
	버스 Arbiter는 한 번에 오직 하나의 Master가 선택되도록 하는 역할을 한다. 고유의 우선순위 알고리즘을 가지고 이러한 arbitration을 하게 된다.

	AHB Decoder
	AHB Decoder의 역할은 Master에서 출력되는 Address의 상위 bit를 가지고서 적절한 Slave를 선택해 주는 것이다.


4. Altera QUARTUS II Ver. 9.0/ ModelSim 설치 및 실행하기

4.1 개인용 PC 권장사양

Alter QUARTUS-II의 Process 시간 등을 고려할 때 개인용 PC의 권장사양은 다음과 같다. 조금 더 낮은 사양에서도 동작이 가능하나 사용 게이트 수가 클 경우 많은 시간이 소요되므로 높은 사양의 PC를 사용할 것을 권장한다.

▪ CPU: Intel Pentium 4, 2.0GHz
▪ RAM: 512MB
▪ OS: Windows XP Professional


4.2 Altera QUARTUS-II 9.0 Web Edition Install 하기

1 Programs 폴더의 90sp2_quartus_free.exe file을 실행하면 아래와 같은 화면이 실행되고 “Next” 버튼을 click
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2 “I accept the terms of the license agreement”를 check 하고 “Next” 버튼을 click
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3 “Next” 버튼 click
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4 설치할 폴더 선택 후 “Next” 버튼 click
(기본 설정은 Altera이며 설정이 완료되면 “Next” 버튼 click)
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5  “Next” 버튼 click
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6 Complete Check 후 “Next”를 click
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7 지금까지 설정한 내용을 Display하고 있으며, “Next” 버튼을 click 하여 설치시작
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8 예(Y) Click
[image: ]

9 설치 완료 후, “Finish” 버튼 click“

4.3 ModelSim 설치하기

1 Programs 폴더의 90_modelsim_ase_windows.exe file을 실행하면 아래와 같은 화면이 실행되고 “Next” 버튼을 click
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2 “Yes” click
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3 Next click

[image: ]
4 설치할 폴더 선택 후 “Next” 버튼 click
(기본 설정은 Altera이며 설정이 완료되면 “Next” 버튼 click)
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5 “Next” click
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6 지금까지 설정한 내용을 Display하고 있으며, “Next” 버튼을 click 하여 설치시작
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7 예(Y) click
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8 설치 완료 후, “Finish” 버튼 click“











4.4 ADS / Multi-ICE 설치 및 실행하기

4.5.1 ADS 설치
1  “ARM Developer Suite v1.2” 폴더에서 Setup.exe를 실행 후 “Next” click
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2 “Yes” click
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3 설치할 경로 선정 후, “Next” click
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4 “Full”로 선택 후 “Next” click
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5 “Next” click
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6 “Next” click
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7 프로그램 설치 중
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8 License를 등록하는 단계로 “다음” click
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9 “Install License” 선택 후, “다음” click
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10 설치 프로그램 폴더중 “Crack” 폴더에서 License.dat 파일 지정

[image: ]

11 “다음” click
[image: ]
12 “마침” click
4.5.2 Multi-ICE 설치

“MULTI-ICE 2.2” 폴더에서 Setup.exe를 실행하여 프로그램을 Install 한다.
(설치과정에서 특별한 선택이 없으므로 Yes 또는 Ok 만 하면 됨)
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4.5.3 CodeWarrior 실행 및 프로젝트 생성

여기에서는 CodeWarrior를 실행하여 원하는 디렉터리에 Project를 만들고, 해당 파일을 추가하는 과정을 알아본다.

1 시작> 프로그램> ARM Developer Suite V1.2> Code Warrior for ARM Developer Suite 실행

[image: ]
2 메뉴바> File> New… click 하면 아래와 같이 Project 설정 창이 나타난다.
[image: ]

3 Project 탭에서 Project name과 Location 을 설정하기 위해서 “Set…” 버튼 click
[image: ]

4 Create New Project 창에서 “파일 이름” 부분에 생성할 Project name을 입력 후 “저장” 버튼 click 한다. 여기에서 설정된 Project name으로 .axf 파일이 생성되고, Location에는 프로젝트가 생성될 폴더를 지정해준다.
[image: ]
5 “확인” 버튼 click

[image: ]

6 마우스의 오른쪽을 누르면 그림처럼 창이 뜨고 Create Group을 click 한다

[image: ]


7 “src” 라는 Group 명을 작성하고 “OK” 버튼을 누르면 폴더가 생성된다

[image: ]
8 앞의 6)~7)의 과정을 반복하여 “init”와 “include”를 추가한다.
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9 해당되는 폴더에 마우스의 오른쪽을 누르고 “Add Files..” 클릭한다.

[image: ]

10 Select Files to add… 창이 화면에 나타나면 main Section이 있는 C source file을 선택 후 “열기” 버튼 click  
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11 Add Files 창이 나타나면 “OK” 버튼 click
[image: ]

12 위의 9)~11)과정을 init와 include 그리고 나머지 file에 대해서도 반복 적용한다.
[image: ]

4.5.4 Target 과 Language 설정 과정

여기에서 Target의 Core설정, 사용할 Language의 Compile설정 및 ARM linker를 설정해준다.

1  Targets 탭을 클릭하면 DebugRel, Release, Debug의 3개가 나타나는데 이것은 각각 최적화 레벨이 서로 다르다. DebugRel은 적당한 수준의 debug 정보를 가지고 최적화가 되고, Debug는 최대한 debug정보를 제공하며, Release는 최대한 최적화함으로 debug 탭을 생성하지 않는다. 우리는 Debug을 선택하기로 한다. Debug을 더블 클릭한다.
[image: ]
2 Post-linker에 ARM fromELF를 설정 한다.
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3 ARM Assembler를 클릭하고 “Architecture or processor”박스에 “ARM926EJ-S”를 선택한다. Equivalent Command line은 설정된 내용들이 display되는 창이기 때문에 직접 작성하지 않아도 된다.
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4 ATPCS 탭을 클릭하고 Software stack checking에서 “off”를 선택한다
[image: ]

5 ARM C Compiler에서 ARM920EJ-S를 선택한다.
[image: ]

6 ARM Linker에서 RO Base를 0x30000000(DPRAM)으로 설정한다.
[image: ]
7 Layout 탭을 클릭하고 “Place at beginning of image”박스 내용을 작성한다.
Object/Symbol: 처음 실행되는 파일을 지정한다. (initmn.o)
Section: 처음 실행되는 파일의 Section을 지정한다. (Init)
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8 Listings 탭을 클릭하고 아래 그림처럼 “Listings” box 안의 내용과 List file을 설정한다. 즉, 컴파일 할 때 사용한 library, memory map 정보, symbol 정보 등을 볼 것인가 설정하고, 그것을 List file에 작성한 파일명(ex: test.map)으로 저장한다.
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9 ARM fromELF을 클릭하고 Project 컴파일에 의해 생성시킬 binary파일을 설정해준다.
Output file name: easy_soc.bin (직접입력)으로 입력한 후 “OK”버튼을 click
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4.5.5 Project Compilation

다음과 같이 메뉴바> Project> Make를 실행한다. 실행 중에 Error가 발생하면 error원인을 찾아서 해결하고, error가 없으면 다음과 같은 화면이 나타나고 error없이 이미지를 생성했음을 알린다. window탐색기로 Project directory 아래 이미지가 생성됐는지 확인한다.
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4.5.6 프로젝트 실행 방법

여기에서는 Multi-ICE Server를 띄어 Core ARM926EJ-S를 detect하는 방법이다

1 Multi-ICE Serer 사용방법
1 Multi-ICE Server 창을 띄운다
2 Auto-Configure를 click하면 해당 Core가 나타난다.

2 이미지 실행
CodeWarrior에서 Project를 컴파일 하면 .axf 파일이 생성된다. 여기에서는 .axf 파일을 AXD 디버거에서 실행하는 방법에 대해 설명하도록 한다.

1 AXD 디버거 창을 띄운다
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2 Option > Configure Target.. click
(Multi-ICE를 제어하기 위한 dll파일을 추가)
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3 File> Load Image를 click
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4 앞에서 만든 Project 폴더 안의 Debug의 경로를 지정하고, easy.axf 파일을 선택 후, “열기”버튼을 click 하여 load한다.

5 F5 버튼을 누르면 프로그램이 실행된다.
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4.5.7Multi-ICE를 이용한 ads에서 만든 axf 파일 실행

1 Multi-ICE와 PC 본체 뒷면에 있는 Parallel Port를 제공된 Parallel Port Cable로 연결한다.
2 Multi-ICE와 Target Board의 ‘ARM JTAG’ 커넥터에 제공된 JTAG Cable로 연결한다.
[image: Photo_0001]

3 Target Board에 전원을 인가한다.
(Multi-ICE는 전원을 Board의 전원을 끌어와 사용하므로, 추가적인 전원 어댑터가 필요 없음)

4 시작> 프로그램> ARM Multi-ICE V2.2> Multi-ICE Server를 실행시킨다.

[image: ]

5 아래 그림은 숫자①은 JTAG의 auto detect 아이콘으로, 이것을 누르면 아래 그림과 같이 JTAG에 연결된 Target processor의 종류가 나타난다.
(숫자①은 Auto SCAN 아이콘이고, 숫자②는 reset 아이콘이다.)
[image: ]
6 시작> 프로그램> ARM developer Suite V1.2> AXD 디버거를 실행
7 AXD 상단 Menu의 Options 에서 Configure Target을 선택한다.
8 “ADD” 버튼을 click하여 Multi-ICE가 설치된 디렉터리에서 Multi-ICE.dll을 찾아서 ADD한다.
(일반적으로 C:\Program Files\ARM\Multi-ICE 에 Multi-ICE.dll 있음)
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9 Multi-ICE.dll을 선택 후 “Configure” 버튼을 click 한다.
10 Location of Multi-ICE 박스 안의 “This computer” 버튼 click

[image: ]

11 ARM926EJ-S가 선택되었는지 확인 후 “확인” 버튼 click

12 File> Load image를 실행해서 *.axf 또는 *.elf file을 memory에 load 한다.

[image: ]

13 메뉴바> Execute의 Menu의 “Go”와 “Stop”을 사용하면 Target Board에서 실행상태를 볼 수 있다.


I I. 설계 실습 
1. ARM을 이용한 TFT-LCD 제어 실습

실험 순서
1 개요
2 TFT-LCD IP를 이용한 EasySoC 시스템 구조 이해
3 TFT-LCD IP AMBA 연결 프로젝트 생성
4 Multi-ICE와 AXD를 이용한 TFT-LCD 제어

4.1 개요

 AHB TFT-LCD IP를 이용하여 AHB Control Register와 Master DMA 설계과정을 이해하고 정상적으로 동작이 되는지 Multi-ICE/AXD 디버거와 firmware를 이용하여 확인한다. 확인하는 과정을 통해서 FPGA 내부에 구성된 플랫폼의 블록 다이어그램을 이해하고, AMBA Bus 구조와 신호들의 동작을 이해하고자 한다.

4.2  TFT-LCD IP를 이용한 EasySoC 시스템 구조 이해

4.2.1 EasySoC 시스템 구성
 
실습 프로그램에는 기본 EasySoC 시스템에 LED/7-Segment, UART, DPRAM, Async. SRAM IP가 연결되어 있으며, 여기에 DMA와 TFT-LCD IP를 추가하여 실습하도록 한다.

 초기 IP
· LED/7-Segment IP : APB Slave 1에 연결
· UART IP : APB slave 2에 연결
· DPRAM IP : AHB Slave 9에 연결
· Async. SRAM IP : AHB Slave 3에 연결
· Async. SRAM Control Register : AHB Slave 2에 연결

 추가 IP
· DMA : AHB Master 2에 연결
· TFT-LCD : control Register : AHB Slave 5에 연결




[그림 1] 초기 EasySoC Platform


[그림 2] 완료 EasySoC Platform

그림 3은 EasySoC Peripheral Memory Map을 나타낸다.



[그림 3] EasySoC Peripheral Memory Map







4.2.1 TFT-LCD 구성 및 동작 설명

1) LCD 종류와 구동원리
- LCD는 구동방식에 따라 passive Matrix와 active Matrix로 나눈다. 
[image: lcm_img_03.gif]
[그림 5 LCD Class]

- Passive Matrix (TN, STN) : Common 전극과 Data 전극을 XY 형태로 배치하고 그 교차부분에 순차적으로 신호를 Display 하는 방식으로 구성이 단순하다.
[image: lcm_img_04.gif]
[그림 6 Passive Matrix]

- Active Matrix (TFD, TFT) : 각 표시 화소마다 전압을 조절하는 스위치로써 박막 트랜지스터(TFT)를 사용하며 독립적으로 화소를 제어하기 때문에 고품질의 화면이 가능하고 컬러표시에 사용되고 있다.
[image: lcm_img_05.gif]
[그림 7 Active Matrix]
(1) TN(Twisted Nematic)  LCD
액정분자가 면에 따라서 Nematic 배향하도록 처리한 유리판을 직각으로 교차시키고 유리판 사이에 액정을 넣으면 액정분자의 배열이 꼬이게 된다. 거기에 전압을 가하면 액정분자가 전계 방향으로 배열을 바꾸며 편향 판을 이 액정 셀에 끼우면 전압 off 시에는 입사 광이 통과하고, 전압 on 시에는 입사 광을 차단하여 명암의 콘트라스트를 얻을 수 있는데 이 효과를 표시장치에 응용하는 것이다.

(2) STN(Super Twisted Nematic)  LCD
동작원리는 TN과 같으나 비틀림 각을 더 주어 전기 광학적 특성의 경사도를 향상시킨 것이다. 

(3) DSTN(Double-STN) LCD
STN 셀을 두 장 중첩한 구조이다. 대형 흑백 액정을 실현하기 위해 액정의 착색을 보장하는 방법으로 하나의 STN 액정과 다른 하나의 STN 액정을 색 보정용으로 포개어 놓은 것이다. 

(4) TFT-LCD
TN의 표시정보량의 한계를 극복하는 다른 방법으로서, 기존의 TN 모드를 그대로 사용하면서 수동구동 대신 능동 구동 방법을 사용한 방식이다. 수동구동과는 달리 전기적 소자(transistor)를 제조하여 각 화소를 직접 구동하기 때문에 콘트라스트, 해상도, 시야각, 응답속도 등에서 수동구동보다 훨씬 우수한 특성을 나타낸다.
 TFT 기술로 만들어진 디스플레이 화면은 노트북이나 랩톱 컴퓨터에 보편적으로 사용되는 액정화면으로서, 각 픽셀마다 하나씩 트랜지스터를 가지고 있다. 각 픽셀마다 트랜지스터를 가지고 있다는 것은 픽셀이 빛이 나게 하는데 보다 적은 전류를 소모하며, 매우 빠르게 끄고 켤 수 있다는 것을 의미한다. 

2) TFT-LCD 구동원리
- 액정의 방향을 유도하기 위해 배향 처리된 면과 액정이 접촉하면 액정 분자들이 배향막골과 평행하게 배열된다.
[image: lcm_img_08.gif]
[그림 8]
- 액정분자가 평행하게 배열된 두 기판을 90도 비틀어지게 배치하면 액정분자는 양 기판 사이에서 연속적으로 90도 비틀어지며 빛도 액정 분자의 방향을 따라서 90도 틀어져 통과하게 된다.
[image: lcm_img_09.gif]
[그림 9]

- TFT를 이용하여 전압이나 외부에서 힘이 인가되면 액의 방향은 꼬임이 풀려서 한 방향으로 panel면에 수직하게 정렬되고 빛은 직진하게 된다. 결국 입사한 빛을 통과시키느냐 마느냐는 액정의 꼬임과 풀림으로 결정하고 양쪽 유리판에 편광판을 부착하여 액정을 통과한 빛을 다시 한 방향으로 모아 화소에 빛을 입사시켜 최종적으로 화면에 나타나게 된다.
[image: lcm_img_10.gif]
[그림 10]
3) Color 구현의 원리
- LCD에서는 색을 구현하기 위해 red, green, blue의 빛의 3원색에 해당하는 color filter를 사용한다. RGB color filter를 인접하게 배치시키고 각각의 color filter에 해당 color 신호를 인가하여 밝기를 제어함으로써 색을 표현하는 것이다.
- 표현 가능한 색의 수는 다음과 같다.
	M = 2^(R) + 2^(G) + 2^(B) = 2^(R+G+B)
M : 표현 가능한 색의 수(bit), R/G/B : 화상 데이터 비트 수



4) TFT LCD 동작
- TFT 소자의 gate, source 전극 들은 하나의 row나 column line을 공유하고 화소들에 그림이나 글자를 나타내기 위해 gate 전극은 시간 분할 방식에 의해 scanning 된다. 예를 들어 3X3 line 일 때 2번째 gate line이 scan 되고 있으며 모든 source 전극 line에 신호 전압이 인가 된다. 이때 두 번째 신호에는 액정을 구동할 수 있는 전압이 인가되고 나머지에는 액정 구동 전압보다 작은 전압이 인가된다면 중간의 화소만 동작 될 것이다. 만약 gate 전극에 pulse가 인가되지 않으면 모든 TFT들은 off 되어 액정 capacitor에 인가된 신호 전압이 유지될 것이다. 이러한 동작 원리에 의해 모든 gate 전극에 순차적으로 pulse를 인가하고, 해당 source 전극에 신호를 인가함으로써 panel의 모든 화소를 구동하는 것이 가능하다.

5) Low driver
- Row driver는 통상 pixel TFT의 gate 전극을 구동한다는 의미에서 gate driver라고도 하는데 순차적으로 gate line을 선택하는 scan 신호를 발생하는 역할을 한다.
- 출력 신호는 시간적인 관점에서 볼 때, 한 frame에 하나의 pulse만 존재하고 어느 출력신호와도 동시에 존재하지 않는 것이 일반적이다.
- Gate pulse가 high level로 유지되는 동안 그 line의 모든 TFT들이 active되어 channel이 열리므로 이를 통해서 신호 전압들이 화소에 충전되는 것이다.

6) Column driver
- Column driver는 TFT의 source 전극을 구동한다는 의미에서 source driver라고도 하며 gate driver가 TFT 에 pulse를 인가해 ON 상태로 만들어 주면 source driver는 신호 선을 통해 실제로 화소에 신호 전압을 인가하는 역할을 한다.

7) TFT LCD IP 구성 내용

(1) 일반 설명
- TFT-LCD IP는 DMA와 2개의 FIFO를 내장하고 있으며 FIFO size는 4byte width 16 depth이다. 
- DMA 역할은 memory의 영상 데이터를 Read하여 FIFO에 적재하는 것이다.
- FIFO 적재 및 Read 방법은 한 FIFO의 16 depth가 다 채워지면 다른 FIFO에 적재를 시작하고 다 채워진 FIFO는 local Bus를 이용해 TFT-LCD 패널 타이밍에 맞춰 전송되는 것이다.
- TFT-LCD Controller는 16bit RGB와 4:2:2 YUV 포맷 영상 데이터만 지원하며 16bit RGB는 5R-6G-5B 포맷으로 표현된다. 

(2) Register Set

	Address
	Name
	Attribute
	Description

	0x00
	LCD_FRAME_ADDR
	R/W
	Frame buffer base Register

	0x04
	LCD_Control
	R/W
	Control Register

	0x08
	LCD_TIMING0
	R/W
	Timing configuration Register

	0x0C
	LCD_TIMING1
	R/W
	Timing configuration Register

	0x10
	LCD_REFRESH
	R/W
	Refresh timing configuration Register

	0x14
	LCD_SIZE
	R/W
	Display size

	0x18
	LCD_HPOS
	R/W
	Horizontal position

	0x1C
	LCD_VPOS
	R/W
	



(3) Register Description

· LCD_FRAME_ADDR : LCD image frame buffer Address Register

	LCD_FRAME_ADDR (0x00)

	31
	30
	29
	28
	27
	26
	25
	24
	23
	22
	21
	20
	19
	18
	17
	16

	

	15
	14
	13
	12
	11
	10
	9
	8
	7
	6
	5
	4
	3
	2
	1
	0

	FRAME_BASE_ADDR

	FRAME_BASE_ADDR
	Image frame buffer base Address for DMA operation



· TFT-LCD에 출력할 RGB/YUV 영상이 저장되어 있는 메모리 영역의 시작주소를 가리키고 본 예제에서는 Async. SRAM을 이용함으로 frame base Address는 0x3800_0000이다. TFT-LCD Controller에 내장된 DMA에서는 이 Address를 기초로 image data를 읽어오기 때문에 TFT-LCD Controller를 구동하기 전에 LCD_FRAME_ADDR가 올바르게 설정되어 있어야 한다.
 




· LCD_Control : LCD Control Register

	LCD_Control (0x04)

	31
	30
	29
	28
	27
	26
	25
	24
	23
	22
	21
	20
	19
	18
	17
	16

	FILL_COLOR

	15
	14
	13
	12
	11
	10
	9
	8
	7
	6
	5
	4
	3
	2
	1
	0

	
	B
	
	W
	Y
	AR
	OD
	INV
	FM
	FS

	FS
	Frame Start
1 : start lcd operation, 0 : stop lcd operation

	FM
	Fill mode
1 : fill entire screen as color specified by FILL_COLOR
0 : fill screen from image frame buffer

	INV
	Inverse pixel data
1 : Inverse pixel value, 0 : Normal pixel value

	OD
	RGB order
1 : RGB, 0 : BGR

	AR
	Auto Refresh
1 : Auto refresh enable, 0 : Window mode disable

	W
	Window Enable
1 : Window mode enable, 0 : Window mode disable

	Y
	Image format
1 : YUV format, 0 : RGB format

	B
	Busy (read only)
1 : indicate Busy, 0 : indicate idle



· FS 필드가 1이면 TFT-LCD 패널에 영상 데이터를 출력한다.
· AR 필드가 0인 경우 1frame만 전송하고 더 이상 영상 데이터를 출력하지 않는다. 일부 TFT-LCD 패널은 한 번 영상이 출력된 후 시간이 지나면 영상이 흐려지는데, 이런 경우에는 AR를 1로 설정하여 주기적 영상을 갱신하는 auto refresh mode를 사용해야 한다. auto refresh mode는 LCD_REFRESH Register의 값을 주기로 같은 영상을 반복해서 TFT-LCD에 출력한다.
· OD 필드는 frame buffer 내의 영상 데이터의 RGB 순서를 지정하는 옵션으로 ‘1’인 경우 RGB로 ‘0’인 경우 BGR로 간주하여 TFT-LCD Module에 영상 데이터를 출력한다. 
· INV 필드는 ‘1’인 경우 16bit RGB 값을 inverse하여 출력한다.
· FM 필드가 ‘1’인 경우 영상 데이터를 memory에 상주하는 frame buffer에서 읽어오지 않고 FILL_COLOR의 값을 출력한다. FILL_COLOR가 0x0인 경우 TFT-LCD Controller가 검은색으로, 0xffff인 경우 흰색으로 채워지며, clear screen과 같은 효과를 낼 수 있다.
· W 필드가 ‘1’인 경우 window 모드를 사용한다. Window 모드는 TFT-LCD 패널의 일부 영역만 이미지 출력을 위해 사용하는 모드이다. Window의 크기와 위치는 LCD_HPOS 레지스터와 LCD_VPOS 레지스터로 설정된다.
· Y 필드가 ‘1’인 경우 YUV 영상 포맷을 사용하고 이 필드가 ‘0’인 경우 RGB 영상 포맷을 사용한다.

· LCD_TIMING0/1 : LCD timing Register

	LCD_TIMING0 (0x08)

	31
	30
	29
	28
	27
	26
	25
	24
	23
	22
	21
	20
	19
	18
	17
	16

	HSEND (HFPORCH)
	HSHIGH (HBPORCH)

	15
	14
	13
	12
	11
	10
	9
	8
	7
	6
	5
	4
	3
	2
	1
	0

	HSLOW (HPORCH)
	CLK_DIV

	LCD_TIMING1 (0x0C)

	31
	30
	29
	28
	27
	26
	25
	24
	23
	22
	21
	20
	19
	18
	17
	16

	
	VSEND (VFPORCH)

	15
	14
	13
	12
	11
	10
	9
	8
	7
	6
	5
	4
	3
	2
	1
	0

	VSHIGH (VBPORCH)
	VSLOW (VPORCH)

	CLK_DIV
	CLK_DIV = 1 (TFT LCD Panel clock divider)



· TFT-LCD의 TFB 영상 출력 timing은 그림 10 과 같다. RGB 데이터의 전송은 행 단위로 전송되며 한 행의 시작은 HSync 신호에 의해 제시된다. 그림에서는 행 단위 RGB 데이터 전송 타이밍을 ‘H’로 표시하고 있다. Image Frame을 시작할 때 Vsync가 일정 시간 동안 low로 유지되어야 하는데 이를 porch라고 부르며 TFT-LCD 패널 제품마다 다르다. 그림 10 에서는 porch가 2H이다. Porch 직후에는 VSync를 일정 시간 high로 유지해야 하는데 이를 back porch라고 하며 그림 10에서 back porch는 2H이다. Back porch 이후에 RGB data가 행 단위로 전송되며 이 기간 동안에는 VSync가 high로 유지되어야 한다. 한 image frame 전송이 끝난 후에는 일정 시간 동안 VSync를 high로 계속 유지해야 하는데, 이를 front porch라고 부른다. 그림 10에서 front porch는 3H이다.
[image: ]
[그림 10 TFT-LCD vertical timing diagram]

· 그림 11은 horizontal timing을 나타낸 것이다. 그림의 vertical timing과 마찬가지로 front poach, poach, back poach가 존재한다.
[image: ]
[그림 11 TFT-LCD vertical timing diagram]
· LCD_TIMING0/1 레지스터는 vertical poach, vertical back poach, vertical front poach, horizontal poach, horizontal back poach, horizontal font poach의 간격을 설정하는 레지스터이다. 아래 표는 LCD_TIMING 레지스터의 각 field들의 이름과 의미를 나타낸 것이다.

	Timing name
	Field name

	Vertical poach
	VSLOW

	Vertical back poach
	VSHIGH

	Vertical front poach
	VSEND

	Horizontal poach
	HSLOW

	Horizontal back poach
	HSHIGH

	Horizontal front poach
	HSEND


· LCD_TIMING0의 CLK_DIV는 TFT-LCD clock 분주를 설정한다. Horizontal poach들은 TFT-LCD clock count로 설정되고, vertical poach들은 horizontal cycle의 개수로 설정한다. 이 때 각 field 값들은 실제 값 -1로 설정한다.

· LCD_REFRESH : LCD refresh period

	LCD_REFRESH (0x10)

	31
	30
	29
	28
	27
	26
	25
	24
	23
	22
	21
	20
	19
	18
	17
	16

	

	15
	14
	13
	12
	11
	10
	9
	8
	7
	6
	5
	4
	3
	2
	1
	0

	REFRESH_INTERVAL

	REFRESH_INTERVAL
	Auto refresh interval divider


· TFT-LCD에 영상을 refresh하는 주기를 설정하는 Register이다. 주기는 TFT-LCD clock count로 설정한다. 이 레지스터는 LCD_Control 레지스터 AR이 ‘1’인 경우에만 의미가 있다.



· LCD_SIZE : LCD display size Register

	LCD_SIZE (0x14)

	31
	30
	29
	28
	27
	26
	25
	24
	23
	22
	21
	20
	19
	18
	17
	16

	
	VS_SIZE

	15
	14
	13
	12
	11
	10
	9
	8
	7
	6
	5
	4
	3
	2
	1
	0

	
	HS_SIZE

	HS_SIZE
	HS_SIZE = horizontal width – 1
If (display width is 480) then HS_SIZE = 479

	VS_SIZE
	VS_SIZE = vertical height – 1
If (display height is 272) then HS_SIZE = 271



· LCD_SIZE 레지스터는 TFT-LCD panel의 해상도를 설정하는 레지스터이다. HS_SIZE는 수평 해상도 – 1 을 설정하고 VS_SIZE는 수직 해상도 – 1 을 설정한다. 예를 들어 수평/수직 해상도가 480/272인 TFT-LCD인 경우에는 각각 479, 271을 설정한다.

8) TFT LCD schematic 정보
· EasySoC platform에는 TS-430T-001B 고급 LCD 패널을 사용한 4.3” color TFT-LCD 모듈을 사용한다. TS-430T-001B의 RGB 신호 및 HSYNC, VSYNC 등의 신호 제어를 통해 TFT-LCD에 디스플레이 할  수 있다. 기본적인 TS-430T-001B의 특성 및 타이밍 다이어그램은 다음과 같다.
[image: ]
[TS-430T-001B features]
[image: ]
[TS-430T-001B 제어 신호 타이밍 다이어그램]
[image: ]
[TS-430T-001B timing characteristics]

9) 4.3” TFT-LCD Module과 FPGA 간에 핀 커넥션
[image: ]


	TFT-LCD CON20

	핀 번호
	신호 이름
	FPGA 핀 번호
	핀 번호
	신호 이름
	FPGA 핀 번호

	1
	LCD_CLK
	L6
	2
	LCD_HSYNC
	L3

	3
	LCD_VSYNC
	L7
	4
	GND
	

	5
	BLUEDATA2
	
	6
	BLUEDATA3
	AF23

	7
	BLUEDATA4
	AF23
	8
	BLUEDATA5
	AD4

	9
	BLUEDATA6
	AD5
	10
	BLUEDATA7
	AD6

	11
	GND
	
	12
	GREENDATA2
	AE22

	13
	GREENDATA3
	AE23
	14
	GREENDATA4
	AF17

	15
	GREENDATA5
	AF18
	16
	GREENDATA6
	AF19

	17
	GREENDATA7
	AF20
	18
	GND
	

	19
	REDDATA2
	
	20
	REDDATA3
	AC24

	21
	REDDATA4
	AC25
	22
	REDDATA5
	AC26

	23
	REDDATA6
	AD24
	24
	REDDATA7
	AD25

	225
	GND
	
	26
	VDD3.3V
	

	27
	VDD5V
	
	28
	VDD5V
	

	29
	VDD5V
	
	30
	GND
	

	31
	SSPSFRM
	
	32
	LCD_BKL_ON
	M2

	33
	NS
	
	34
	VDD3.3V
	

	35
	NS
	
	36
	NC
	

	37
	SSPSCLK
	
	38
	SSPRXD
	

	39
	SSPTXD
	
	40
	nPIRQ
	

	41
	TSPX
	
	42
	TSMY
	

	43
	TSMX
	
	44
	TSPY
	



4.2.2 디자인 블록 다이어그램
 EasySoC에서 구현할 시스템의 블록 다이어그램이다. TFT-LCD를 제어하기 위한 AHB IP를 설계한 후 Async.SRAM에 영상 이미지를 저장하고 이를 계속적으로 Read 하여 TFT-LCD에 전송한다. 또한 TFT-LCD Control Register에 필요한 정보를 firmware로 작성 후 DPRAM에 load하여 IP에 대한 검증이 가능하도록 SoC를 설계한다.
 TFT-LCD 구동 시스템은 두 개의 AHB Master와 세 개의 AHB Slave로 구성된다. 두 개의 AHB Master는 ARM926 코어와 TFT-LCD Controller에 내장된 DMA이며, 세 개의 AHB Slave는 DPRAM, Async. SRAM 과 TFT-LCD Control Register로 구성되어 있다. TFT-LCD Controller는 내장된 DMA를 사용하여 RGB 이미지 데이터 또는 YUV 이미지 데이터를 TFT-LCD 패널의 타이밍에 따라 읽어온다.
구현하고자 하는 시스템의 블록 다이어그램은 아래 그림과 같이 구성되어 있어 AXD 디버거에서 Async. SRAM에 stream 데이터를 저장하고 TFT-LCD Controller는 Async. SRAM에 있는 이미지 데이터를 TFT-LCD로 디스플레이 하도록 구성한다.

1) ARM926 Core에서는 AMBA HCLOCK/HRESETn을 공급하며, FPGA와의 Interface는 AHB로 통신한다. TFT-LCD Control IP은 AMBA AHB에 연결되어 있다.




[EasySoC 시스템 블록 다이어그램]

2) 이제 FPGA에 구현할 상세한 블록 다이어그램을 보도록 하자.
아래 그림을 보면 TFT-LCD IP는 AHB Control Register와 local Register를 통해서 연결되어 있고, AHB Master DMA는 local Register를 통하거나 직접 연결되어 AMBA AHB에 연결되어 있다.


[FPGA 내부의 AHB Slave 상세 블록 다이어그램]

3) 기본 시스템을 구현했을 때 FPGA 내부 신호의 흐름을 살펴보면 다음 블록 다이어그램과 같다.
TFT-LCD IP는 AHB DMA/Control Register에 연결되어 있다.


[FPGA 내부의 AMBA 신호 흐름도]
4.3 TFT-LCD IP AMBA 연결 프로젝트 생성

4.3.1 Project file 설명

1) 완성된 Project hierarchy

[image: ]

2) APB Design file ( 파일 위치 : \rtl\Segment_led )
(1) seven_seg.v : 7-Segment IP
(2) apb-seg_charlcd.v
-  LED IP
-  Address Decoder(PADDR[7:0])에 의한 LED / 7-Segment 선택 후
PWDATA 입력 및 PRDATA 전송
(3) apb_seg_charlcd_rec.vhd
-  apb_seg_charlcd.v를 Module 선언
-  AMBA APB net 연결

3) APB Design file ( 파일 위치 : \rtl\uart )
(1) UART.vqm : UART IP
(2) uart_rec.v
-  UART.vqm를 Module 선언
-  AMBA APB net 연결

4) AHB Design file ( 파일 위치 : \rtl\dpram_2 )
(1) AHB2PORT1RAM.v : DPRAM IP
-  BRAMs.v Module 선언
-  AMBA AHB net 연결 : AHB Slave Wrapper
(2) BRAMs.v : Altera FPGA internal DPRAM

5) AHB Design file ( 파일 위치 : \rtl\async_sram )
(1) async_sram_ctrl_ahb32_2.vqm : async. SRAM IP
(2) async_sram_ctrl_ahb32_rec.v : async_sram_ctrl_ahb32_2.v의 top file
- async_sram_ctrl_ahb32_2.vqm를 Module 선언
- AMBA AHB net 연결

6) AHB Design file ( 파일 위치 : \rtl\tftlcd_ctrl )
(1) TFTLCDCTRL.vqm : TFT-LCD IP
(2) tftlcdctrl_rec.v : TFTLCDCTRL.vqm의 top file
- TFTLCDCTRL.vqm를 Module 선언
- AMBA AHB net 연결

1.1 TestBench 생성 방법 및 Simulation 방법
설계 목표 시스템을 Verilog로 Coding을 한 뒤에 Download하기 전에 목표대로 동작을 하고 있는지 확인하기 위해서 Simulation을 한다. Simulation을 하기 위해서는 이에 해당하는 Signal을 넣기 위한 Test Bench가 필요하게 된다. 다음은 그 Test Bench를 이용하여 시스템의 동작을 검증하는 방법에 대하여 설명한다.
A. Test Bench를 작성하여 Compile된 파일을 불러서 시뮬레이션 하는 방법
i. Design top위의 Cyclone2 : EP2C50F672C8를 더블클릭한다. 
[image: K-1]

ii. Settings창이 뜨면 EDA Tool Setting => Simulation 을 클릭한다.
[image: K-3]

iii. Tool name을 ModelSim-Altera로  선택하고 Format for output netlist를 Verilog HDL, Time Scale을 1PS, 그리고 Output Directory를 지정해 준다.
[image: K-4]

iv. Compile을 진행하면 Simulation 파일인 *.vo 와 *.sdo 파일이 생성된다.
[image: ]

v. Altera ModelSim을 실행시켜 Output Directory로 가서 Compile된 *.vo 파일을 포함하여 프로젝트를 생성한다.
[image: K-6]

vi. Cyclone2 Library를 연동하기 위해서 Altera => 90sp2 => quartus => eda => sim_lib => cycloneii_atoms.v 를 불러와서 같이 Compile을 한다.
[image: K-8]

vii. Test Bench 파일을 불러와서 같이 Compile을 해준다.
[image: K-9]

viii. Simulation을 실행하면 확인할 수 있다.
[image: K-10]

ix. 실행도중 *.sdo 파일을 찾을 수 없다는 Error가 생길 경우 프로젝트 폴더 안에 *.sdo 파일이 있는지 확인한다.
[image: K-11]

x. 그래도 실행이 안될 경우 *.vo 파일을 열어서 *.sdo 파일의 경로를 설정해 준다.
[image: K-12]

B. Quartus2에서 직접 Test Bench를 작성하여 시뮬레이션 하는 방법
i. 위의 i~iii까지 진행을 하고 More EDA Netlist Writer Settings… 를 클릭한다.
[image: K-4]

ii. Location of user complied simulation library를 Altera => 90sp2 => quartus => eda => sim_lib로 경로를 설정해준다.
[image: K-14]

iii. Generate third-party EDA tool command script without running the EDA tool을 OFF로 설정한다.
[image: K-15]

iv. Processing => Start => Start Analysis & Elaboration을 클릭한다.
[image: K-16]

v. Compile이 끝나면 Tools => Launch EDA Simulation Library Compiler 를 선택한 뒤 Selected families에 Cycloneii를 추가한다.
[image: K-17]

vi. Processing => Start => Start Test Bench Template Writer 를 선택한다. 그럼 Simulation/Modelsim에 Test Bench 파일인 *.vt 파일이 생성된 것을 확인 할 수 있다.
[image: K-18]

vii. 생성된 Test Bench 파일을 프로젝트에서 불러와서 Initial과 Always구문들 사이에 Signal을 만들어 준다. 
[image: K-19]

viii. 끝나면 프로젝트 Setting에서 Simulation으로 들어간 뒤에 Compile test bench를 클릭하고 test bench를 추가한다.
[image: K-20]

ix. Compile을 한 뒤에 Tools => Run EDA Simulation Tool => EDA RTL Simulation을 클릭하여 ModelSim – Altera 를 실행시킨다.
[image: K-21]

x. Compile이 끝나면 Simulation을 실행시켜 동작을 확인한다.
[image: K-10]

C. TestBench 설명
기본적으로 Test Bench를 생성하면 프로젝트의 I/O Port 및 Reg, Wire 선언은 되어 있으며 생성된 Test Bench에서 추가해야 하는 것은 초기값 설정 및 I/O Signal을 설정해야 한다. 다음은 TFT-LCD를 기준으로 만들어진 Test Bench이며 추가한 초기값 설정 및 I/O Signal은 붉은색으로 표시하였다.

`timescale 1 ps/ 1 ps

//모듈선언
module design_top_vlg_tst();

// constants                                           
// general purpose registers
reg eachvec;

// test vector input registers
reg CTS0;
reg RXD0;
reg [3:0] dma_clr;
reg [3:0] dma_tc;
reg hclk;
reg hresetn;
reg mas_hgrant;
reg mas_hready;
reg [31:0] treg_mem_data;
reg [31:0] slave_haddr;
reg [2:0] slave_hburst;
reg [31:0] treg_slave_hdata;
reg [3:0] slave_hmaster;
reg slave_hmastlock;
reg [3:0] slave_hprot;
reg slave_hreadyin;
reg slave_hsel;
reg [2:0] slave_hsize;
reg [1:0] slave_htrans;
reg slave_hwrite;

// test vector output wires 
wire RTS0;
wire TXD0;
wire [3:0] dma_req;
wire [9:0] dot_col;
wire [13:0] dot_raw;
wire [3:0] iint;
wire [7:0] led;
wire mas_hbusreq;
wire mas_hlock;
wire [17:0] mem_addr1;
wire [17:0] mem_addr2;
wire [31:0] mem_data;
wire [3:0] mem_nbe;
wire mem_oe1;
wire mem_oe2;
wire mem_sram_ncs0;
wire mem_we1;
wire mem_we2;
wire [7:0] segcom;
wire [7:0] segout;
wire [31:0] slave_hdata;
wire slave_hreadyout;
wire [1:0] slave_hresp;
wire [15:0] slave_hsplit;

// TFT-LCD output wires
wire [15:0] 	LCD_D;
wire LCD_VSYNC;
wire LCD_HSYNC;
wire LCD_DE;
wire LCD_CLK;
wire LCD_LEND;

// assign statements
assign mem_data = treg_mem_data;
assign slave_hdata = treg_slave_hdata;

//assign paramter
parameter clock_cycle = 15.1; //66Mhz clock frequency
parameter lcd_hori = 272; //TFT - LCD 가로
parameter lcd_vir = 480; // TFT - LCD 세로
parameter lcd_size = lcd_hori*lcd_vir; // TFT - LCD 크기

///////////////////////////////////top///////////////////////////////////////////
design_top i1 (
// port map - connection between master ports and signals/registers   
	.CTS0(CTS0),
	.RTS0(RTS0),
	.RXD0(RXD0),
	.TXD0(TXD0),
	.dma_clr(dma_clr),
	.dma_req(dma_req),
	.dma_tc(dma_tc),
	.dot_col(dot_col),
	.dot_raw(dot_raw),
	.hclk(hclk),
	.hresetn(hresetn),
	.iint(iint),
	.led(led),
	.mas_hbusreq(mas_hbusreq),
	.mas_hgrant(mas_hgrant),
	.mas_hlock(mas_hlock),
	.mas_hready(mas_hready),
	.mem_addr1(mem_addr1),
	.mem_addr2(mem_addr2),
	.mem_data(mem_data),
	.mem_nbe(mem_nbe),
	.mem_oe1(mem_oe1),
	.mem_oe2(mem_oe2),
	.mem_sram_ncs0(mem_sram_ncs0),
	.mem_we1(mem_we1),
	.mem_we2(mem_we2),
	.segcom(segcom),
	.segout(segout),
	.slave_haddr(slave_haddr),
	.slave_hburst(slave_hburst),
	.slave_hdata(slave_hdata),
	.slave_hmaster(slave_hmaster),
	.slave_hmastlock(slave_hmastlock),
	.slave_hprot(slave_hprot),
	.slave_hreadyin(slave_hreadyin),
	.slave_hreadyout(slave_hreadyout),
	.slave_hresp(slave_hresp),
	.slave_hsel(slave_hsel),
	.slave_hsize(slave_hsize),
	.slave_hsplit(slave_hsplit),
	.slave_htrans(slave_htrans),
	.slave_hwrite(slave_hwrite),
// TFT-LCD output
	.LCD_D(LCD_D),
   .LCD_VSYNC(LCD_VSYNC),
   .LCD_HSYNC(LCD_HSYNC),
   .LCD_CLK(LCD_CLK),
 .LCD_LEND(LCD_LEND)
);
//////////////초기화////////////////////////////
initial                                                
begin                                                  
  hclk = 0; 
	hresetn = 0; 
	slave_haddr = 0; 
	slave_hsize = 1;
	slave_hwrite = 0; 
	slave_hburst = 0;
	slave_htrans = 0; 
	slave_hprot = 0; 
	slave_hsel = 1; 
	slave_hreadyin = 1; 
	slave_hmaster = 5; 
	slave_hmastlock = 1; 
	CTS0 = 0; 
	RXD0 = 0;
	#10 hresetn = 1;
	#10 hresetn = 0;                                            
$display("Running testbench");                       
end  

///////////////////////////////////Signal 생성////////////////////////////////////////                                                  
always                                                 
// optional sensitivity list                           
// @(event1 or event2 or .... eventn)                  
begin                                                  
  #clock_cycle hclk = ~hclk;   //Clock
	#400 slave_haddr = slave_haddr + 1; //32bit Slave Address Bus
	#(clock_cycle*lcd_size) slave_hwrite = slave_hwrite + 1; //High일 때 Write Transfer, LOW일 때 Read Transfer
	#(clock_cycle*lcd_size) slave_hreadyin = slave_hreadyin + 1; //HIGH일 때 Bus상에서 Transfer 완료된 것을 의미                                       
end     
                                               
endmodule
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2. Features {
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Display Size. (Diagonal) | 43 =

Display Format 480(W) x RGB x 272(H) dots
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